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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual nhame

OMRON 1610-E1 Model CK3E-11710 CK3E-series Programmable
Multi-Axis Controller Hardware
User’s Manual

OMRON 0036-E2 Model CK3M-CPU11 | CK3M-series Programmable
Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model Industrial PC Platform NY-series IPC
NY512-A6001XX21391 | Programmable Multi-Axis Controller
X Industrial Box PC Hardware User’s
Manual
OMRON I1576-E1 Model R88M-K[] Servomotors/Servo Drives (Built-in
Model EtherCAT® Communications)
R88D-KNLI-ECT User’s Manual
DT 0014-E - Power PMAC User’s Manual
DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and I/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESlI files into the Power PMAC IDE, to easily allocate
slave process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) 1t is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of April 2019.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property

/A WARNING

damage.

f C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to operate the OMRON servo drivers
(G5-series EtherCAT communication built-in type, hereafter referred to as Servo Driver) using
the motion program for OMROM Programmable Multi-Axis Controller (hereafter referred to as
the Controller), model CK3E-OOOO/CK3M-CPULC1/NY510-AOCO, as well as for
checking the operation.

In the document, Servo Driver and servomotors to be connected are collectively called motion
control devices. Servo Driver may also be referred to as a slave depending on the
explanation.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT. In this document, the motion
program is used to check operations.

The range of usage of this document is checking the connection of motion
control devices connected via EtherCAT. When using instructions and
constructing systems that are not described in this document, always read and

follow the information provided in all Safety Precautions and Precautions for

Safe Use in the manuals for each device that is used in the system.




5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices
The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Controller Model CK3E-OOO0O0O
OMRON Programmable Multi-Axis Controller Model CK3M-CPU1]1
OMRON Programmable Multi-Axis Controller Model NY510-AOO0O

Industrial Box PC
OMRON Servo Driver Model R88D-KNLI-ECT
Model R88D-KNCI-ECT-L
OMRON AC Servomotor Model R88M-K L[]

El Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as

follows:

Model R88D-KNLI-ECT

Model NY51L-ALLIH Model R88D-KNT-ECT-L

Power PMAC IDE

EtherCAT
communications

Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model NY510-A0000 Ver.2.5 or later
Controller
Servo Driver (G5-series
OMRON with Built-in EtherCAT Model R88D-KNO1L-ECT | Ver.2.1

Communications)
Ethernet cable (with

. ) Model
OMRON industrial Ethernet XSEW-T421-C0MO-K
connector)
DT Power PMAC IDE Ver.4.2.1.19

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information
This document describes model NY51[]-ACIC0 as an example. The same procedures can
apply to model CK3E-O OO/ CK3M-CPU1[1.

©



EtherCAT Connection Procedure

This section describes the procedures to connect the Controller and Servo Driver via
EtherCAT, and to operate the motion control devices. The description assumes that the
Controller is set to factory default.

If an uninitialized Controller is used, the motion control devices may perform
unexpected operations upon power-on depending on the Controller status,
resulting in a personal injury to the user.

To prevent unexpected operations of motion control devices, be sure to initialize
the Controller before connecting the motion control devices and the Controller

via Ethernet cable.

I 6.1. Workflow

Take the following steps to operate the motion control devices after connecting the Controller
and Servo Driver via EtherCAT.

6.2 Preparation for the Controller Setup Prepare the Controller settings.

v

6.2.1 Creation of a New Project

v

6.2.2 Initial Settings of the Controller

v

6.3 Installation of ESI Files Install the ESI file for Servo Driver

\v4 into Power PMAC IDE.

6.4 EtherCAT Communications Setup Set up EtherCAT communications.

v

6.4.1 Communications Setup for the EtherCAT Master

v

6.4.2 Distributed Clock Setup

6.4.3 PDO Map Settings

v

6.4.4 Creation of an EtherCAT Network Information File

v

6.5 Controller Settings Set up the Controller.

10

v

6.5.1 EtherCAT Communications Check




6.5.2 Motor Setup

v

6.5.3 Creation of Operation Check Programs

v

6.5.4 Project Data Transfer and Operation Check

11



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE on the computer in advance.

6.2.1. Creation of a New Project

Turn on the power to the
1
Controller.

2 Start Power PMAC IDE.

* |f the dialog for confirming [d
access rights appears upon FowerBMAC
start-up, select starting of Power S
PMAC IDE.

3 The Communication screen
appears. Specify the IP address

Communication

85 34|

of the destination Controller and T aiess 1921600200
click Connect. tocol S5H

Paszword SS90
SelectDeviceAtStartup True

* The IP address of the Controller

is set to “192.168.0.200” by Sut T Adness

default.

* If necessary, Change the Gonnect ] [ Last Session IP ] [ Mo Device ]

Windows IP address to For detailed setup options go to Tools menu -> Options
-> PowerPMAC

“192.168.0.X".

4 Power PMAC IDE starts, and is
online to the Controller.

12



5 From the File menu, select New
then Project.

Mew

Chise
Chote Project
Uplead Project Fram PowerfMAC

Save Selects
W Save Al
Export

Cerle Shift« $

Impest

Page Setup.

Fecent Propects and Solubons

B Ea Alr-Fd

PPLNC_Projectsource
PawerPMACL
PPCNC ProjectSodrce

Examples

i3 Project.. CarleShiftsH
3 File— N

» Attach., =
Jog Ribbon | B Task Maneger [T &

PowerPMAC Configuration Warkflow

Create New Project H ‘System Falder ii

o Ethes CAT

EtherCAT

Load PDO Mapgin:

Add and Setup Motors

6 Enter a project name and
location, and select OK.

I ¢ e Sotby: Defaut . = i
+ ntated — )
I PowePaal PowePMAL Type: PewePMAC
PonerPMAC e — — R
PoweiPMAL Schaien I ] PomePMAC b EhrCAT (Acsoti) PoweiPMAC I‘“‘"" suppon ensbled
Pomrinick LY PewarPMAC
Harme: [Fsa0-138_ 1
Lecatien: CAlbsersdellsbau Documents! PowerPMAL D -] [t |
Sekamn name -1 [ Creste deecrzry fer schaifn
T |
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6.2.2.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary

data in advance.

Initial Settings of the Controller
Configure the initial settings for the Controller.

In the Terminal tab page, type
the $3$*** command to reset the
Controller to factory default.

Terminal

[ |Sssmm|
erminag

2 Select System — CPU — System

in the Solution Explorer.

Plot

Solution Explorer 3 x
@ o-a|p -
Search Solution Explorer (Ctrl+;) y-

] R88D-1SN

4 [ System

4 [ EtherCAT
& Masterd (Deactivated)

[ Motors
[ Coordinate Systems

P [ Encoder

b [ Clanguage

b [ Configuration

P [ Documentation

b [ Log

b [ PMAC Script Language

Solution Explorer

3 Select Global Clock.

PU Settings

Global Clock Commanly Uied
‘ Structure hements

Asvanced View

14



4 Specify Servo Frequency.

Select the Servo Frequency
setting from 4 kHz, 2 kHz, or
1 kHz.

= |

Global Clock Settings

Phase Frequency 1 kHz

Servo Frequency 1000 - kHz

5 Click the Accept button.

watch window before moving further with setup
program.

= Commonly Used Structure Elernents Accept

6 If you have changed the servo
frequency setting, type the save
command in the Terminal tab
page of Power PMAC IDE.
When complete, the “Save
Complete” message appears in
the Terminal tab page.

PowerkMAC Messages JEUGILEN Terminal Output

7 Click Delta Tau —
Communication Setup on the
toolbar to display the Device
Properties dialog box.

File Edit View Project Build Debug Tools golekiodou l Ehecal _iiod el
E ‘ Fal] ] .H | 5 Communication Setup - B Start - |
i @ StartPage ¥ Communication Setup | [=] Termina Terminal | 7] Task Manager [7] Advanced Tunin
‘ Sm—— € Position
Watch
Status
A Erors Display
Unsolicited Messages
Jog Ribbon Ttems
Phase Frequency T PowerPMAC Messages kHz Servo Period (mae
f Encoder Conversion Table PhaseQverServoPs
f} Compensation Table
Servo Frequency kHz
& Update Firmware
& DeviceImaging
ik Backup Restore EtherCAT
o . detected,
ools sys CPUTI
Troubleshooters » SenvoPeri
Accepting
Compare 3 . the termin
Check 'sye
X Kill Motors Ctrl-Alt+K T
proaram

15



S In the Device Properties dialog
box, select No Device for IP
Address, then click the Apply
button.

This operation sets the
Controller to the offline state.

,

Test

IP Addrezs
Part
Protocol
Usger

Mo Device

55H
root

A e »

IP Address
Set IP Address

Restart the Controller.

The servo frequency that has
been set is reflected.

10

Wait until the startup process of
the Controller is complete. Then
click Delta Tau —
Communication Setup on the
toolbar to display the Device
Properties dialog box.

In the Device Properties dialog
box, return the IP Address to the
previous setting, then click the
Apply button.

This operation sets the
Controller to the online state.

L bl
[ Test ] Apply ]
|
IP Addrezs 192.16%.0.200

Part
Protocol
zer

55H
root

IP Address
Set [P Addreszs

16



I 6.3. Installation of ESI Files
Install the ESI file for Servo Driver into Power PMAC IDE.

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 From the EtherCAT menu of

File Edit View Project Build Debug Tools DeltaTa
f@-0[F-u-u M [2-e -4 RS \
Power PMAC IDE; SeleCt ESI : @ StartPage s¥ Communication Setup | 5=] Terminal ) Positl® Mg Ribbon | [ Task Manager [f1] Advanced Tuni
Manager. Sotem = X ‘
Global Clock Settings
Items
Phase Frequency 1 kHz
Servo Period (ms
PhaseOverServol
Servo Frequency kHz
EtherCA™
detected
sys.CPU
ServoPe
Acceptin
®
2 Confirm that Omron o
R88D-KNxxx-ECT.xml is
registered in the ESI file list of
ESI Manager.
If it is not yet registered, click :
_ ' rrerer
Add File and register Omron o
R88D-KNxxx-ECT.xml.
l it
—= ]
et >F
Fe same - Supponed Fles ("amt" 2p) i
 Ogen Cane r

3 Click Close to close the ESI
Manager page.

I 6.4. EtherCAT Communications Setup
Set up EtherCAT communications.

17



/A WARNING

Depending on the Controller status, unexpected operations of the motion
control devices may occur when the power to the Controller is turned on,

resulting in a personal injury to the user.
Pay attention to safety when the power is turned on.

IE' Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet
cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

2 Select System — EtherCAT —

Master0O (Deactivated) in the e
Solution Explorer > 1 x
Solution Explorer. @] o a] A=
Search Solution Explorer (Ctrl+; P~
] R88D-1SN
4 | System
4 [z CPU
e & System
[ Hardware
1 ﬂ;a;cmlnemiuam) |

(13

(4 Coordinate Systems
b [ Encoder
[3 C Language
[3 Configuration

3 Documen tation
[ Leg
[ PMAC Script Language

v v v v v

Solution Explorer

18



3 In the Master tab page, specify a

communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

rre— |

Device Editer.
Master | Tapology View

Genersl

I Cycle Timi lut] 0 I

Slaves comnected to local system
Metwesk Adaptee

Slaves comnected to remete system
1P Addvess 192.168. 0 .20
Port WX

Master-Instance

Metverieies: | | Slaves 0 Sate

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

Select System — EtherCAT in
the Solution Explorer and
right-click on Master0
(Deactivated), then select Scan
EtherCAT Network.

Solution Explorer
G| o-a|p -
Search Solution Explorer (Ctrl+;) P~

] R88D-1SN
4 [ System
4 [ CPU

&1 System

[ Hardware

4 [ EtherCAT

7|

Configuration Mode
Diagnosis Mode
I Scan EtherCAT Metwork I

Append Slave
Paste Slave Ctrl+V
Import Slaves from ENI

Export ENI File

Load Mapping to PowerPMAC

Load Mapping to PowerPMAC From EMI

Activate EtherCAT

Edit Topology

EoE Endpoint Configuration
& Open

Scope to This

operties -

New Solution Explorer View

#  Properties Alt+Enter

Make sure that the slave is
displayed in the Solution
Explorer.

Solution Explorer

D o-aF =
Search Solution Explorer (Ctrl+;)
] KNO1L-ECT

4 |7 System

b 3 CPU

[ Hardware

4[] Masterd (Deactivated)
[ Slave 1001 [R88D-KNOIL-ECT] (1001)

=
[ Coordinate Systems
b 3 Encoder

[ CLanguage

[ Configuration

[4 Documentation

[ Leg

[ PMAC Script Language

19



6.4.2. Distributed Clock Setup

1 Setting Distributed Clocks (DC)
for Master

In the Master0 (Deactivated) tab

page, select Distributed Clocks
tab.

Master) (Deactivated) + X

Device Editor

[
| Master [Topology View | Process DataImage | Variables | Advanced Options [ Siave to Slavel Distributed Clocks |ITa;ks + Sync Un

General
Unit Name EtherCATSuite Master
Cycle Time [us] ‘1000

Source MAC address

00-13-95-25-01-40

Slaves connected to local system
MNetwork Adapter o-H, 7

O—7)l TUFHE#E 5 ( Intel(R) 1210 Gigabit Network Connection #3

Slaves connected to remote system

1P Address 192 . 168 . 0 . 200
Port 6000
Master-Instance 0

2 Select Master Shift (EtherCAT
Master Time controlled by
Reference Clock).

Master) (Deactivated) + X
Device Editor

[ Master | Topology View | Process Data Image | Variables | Advanced Options [ Slave to Slave | Distributed Clacks | Tasks + Sync Units|
Reference Clock

Name Slave_1001 [R38D-15NO1L-ECT] (1001)

Clock Adjustment
I @ Master Shift (EtherCAT Master Time controlled by Reference Clock) I

() Bus Shift (Reference Clock controlled by EtherCAT Master Time)

() External Mede (Reference Clock controlled by External Sync Device)

Options
] Sync Window Menitoring
[] Show 64Bit System Time

Slaves with active DC
Slave_1001 [RS8D-15MOLL-ECT] (1001)

20



3 Setting Distributed Clock (DC)
for the Slave

In the Solution Explorer, select
the target slave and display the
Distributed Clock tab page.

Dievice Editar

fGenenl | FO0 Mappng | Variables | Avanced Ogoongl O

Distiiboted Cleock
D Syned

Sni Time (us)

Sleve 1001 [RIE0-KHNOLL-ECT] 001y & X

4 Select the Overwrite Mode
check box and specify Shift
Time.

T

Operstion Mode
i

T tyme Units
7 Sync Unitd
Cyele Tome
@ Syne Unit Cycle al = | 1000w

s
EH |

I Shift Tome fus)

Sy Unit §
Cyele Time
0w

General | PDO Mapping | Vasables | Advanced Options | Dtributed Clock |1t Commands | Cok Gbyest-Dichanery | 2[4

Slave_ 1001 [RESD-KNOLL-ECT] (1001} = X

R o-@F -

23 kwoLLact
4 o System
5 [ cou
3 Hurdwse
+ [ BhercaT
4 # Masterd {Desctivated)
[ Slavn 1001 [RASD-KNOIL-EC
3 Meotces
3 Cocrdinste Systems
¥ [ Encoder
3 € Language
1 Ceriguration

3 Log
~ PMAC Script Lanquige

Correspondence between the servo frequencies of the
Controller and the Shift Time values is as follows:

4 kHz : 125 us
2 kHz : 250 us
1 kHz : 500 us

21



6.4.3. PDO Map Settings

PDO entries without axis settings are subjected to PDO communications as
indefinite values. For this reason, unexpected operations of the motion control
devices may occur, resulting in a personal injury to the user.

Only objects to be configured in Section 6.5.2. Motor Setup must be mapped to
PDO entries.

1 In the Solution Explorer, select
the target slave and display the
PDO Mapping tab page.

2 Setting PDO mapping (Inputs) Inputs

PUSTIOTT aCI0aT VaTue UGS U 52 "
Touch probe status 0x60B9:00 16

Make sure that the 258th Touth probe pos. pos valu | 0X60BA:00 32

transmit PDO Mappl ng Touch probe pos2 pos valu | 0xE0BC:00 32

0x1BO01 check box is selected in Frrarcode (re0sraa ©

the |nputs fleld Digitﬂ_l inputs Qx60FD:00 32
| 258th transmit PDC Mapping 0x1B01
Name Index Bit Length
Error code 0x603F.00 16
Statusword 0:6041:00 16
Position actual value 0x6064:00 32
Torgue actual value 006077:00 16
Following error actual valu = 0x50F4:00 32
Touch probe status 0:060B9:00 16 hd

A Reletn

[=H

22




3 Setting PDO mapping (Outputs)

Clear the 258th receive PDO
Mapping 0x1701 check box in
the Outputs field.

Select the 258th receive PDO
Mapping 0x1704 check box.

Outputs

1st receive PDO Mapping [excluded | 0x1600 -
Name Index Eit Length
Controlword 0x5040:00 16
Target position 02607 A:00 32
Touch probe fu 0we0BS:00 16
258th receive PDO Mapping 01701
MName Index Eit Length
Controlword 0:5040:00 16
Target position 02607 A:00 32
Touch probe fu 0ws0BS:00 16
Physical output 0x60FE0L 32

258th receive PD'O Mapping (exclude 0x1702
Name Index Bit Length

23



6.4.4. Creation of an EtherCAT Network Information File

Selution Explorer - h

Select System — EtherCAT in

1 s @ o-a|p =
the Solution Explorer and Search Solution Explorer (Ctrl+)
right-click on Master0 puttiriod

b [ CPU

(Deactivated), then select Load
Mapping to PowerPMAC.

[ Hardware
4 [ EtherCAT
* sterl (Deactivated)
Slave_1001 [R88D-KMNO1L-ECT] (1001

Configuration Mode

Diagnosis Mode
Scan EtherCAT Network nate Systems
er

ge
Paste Slave Ctrl+V ition

Append Slave
Import Slaves from ENI fation
Export ENI File

Load Mapping to PowerPMAC

Load Mapping to PowerPMAC From ENI
Activate EtherCAT

ipt Language

Edit Topology

EoE Endpoint Configuration
& Open

Scope to This
B MNew Selution Explorer View

Properties Alt+Enter

2 Anenixmlfile is added under e —
@ o-a|p -
the Configuration directory in Seatch Solution Explorer (Clr;) »
. b 3 CPU
the Solution Explorer. (3 Hardware

4 | EtherCAT
4 [ Masterd (Deactivated)
B Slave 1001 [RB8D-KNOLL-ECT] (1001)
1 Motors
[ Coordinate Systems
P [ Encoder
P [ Clanguage
4 [ Configuration

voerg
[ pp_customn_savetpl
=] pp_disablett
=] pp_inc_disable.tet
=] pp_inc_startup.bet
[ pp_save.cfg
=] pp_startup.bit
[ systemsetup.cfg
P [d Documentation
P [ Leg
4 |5 PMAC Script Language
4 [ Global Includes
[ global definitions.pmh
[ ECATMap.pmh
[ Kinematic Routines
P [ Libraries
b 3 Metion Programs

P [ PLC Programs i
Soltion Explore: [T

24



3 An ECATMap.pmh file is added soltion txplorer T
under the PMAC Script search ﬁ‘?r. ‘C:T o
Language/Global Includes " B b

4 [ EtherCAT
f Slave 1001 [R88D-KNO1L-ECT] (1001)
d Motors
1 Coordinate Systems
b 3 Encoder
b [ Clanguage
4 [ Configuration
[ ECATConfig.cfg
] enixml
[ pp_custom_save.cfg
[ pp_custom_save.tpl
=] pp_disablett
=] pp_inc_disable.bdt
=] pp_inc_startup.bt
[ pp_save.cfg
=] pp_startup.bet
[ systemsetup.cfg
b [ Documentation
b [ Log
(= PMAC Seript Language
4 [ Global Includes

I [} ECATMap.pmh I
L m: Houtines
b 3 Libraries
b [ Motion Programs
B[4 PLC Programs

Solution Explorer

directory in the Solution
Explorer.

[

I 6.5. Controller Settings

6.5.1. EtherCAT Communications Check
Take the following steps to ensure that EtherCAT communications are available.

From the Terminal tab page, run
the ECAT[0].Enable=1
command to start EtherCAT
communications.

1

ECATI0].Enable = 1

o~ Terminal MEGIGEN Output

In the Terminal tab page or
Watch Window, make sure that

Command/Query Response
the ECATI[0].Enable value turns

Sys.ServoCount 7712293
to 1.

IecaT[D].EnabIe 1
*The OP mode is entered and ecat[0].MasterState P8
EtherCAT communications are Motor[1].ActPos 2

established.

25



After making sure that correct
communications are available,
run the ECAT[0].Enable=0

command from the Terminal tab

page to stop EtherCAT
communications.

cmmunicatiol

werP

ECATI[0] Enable = 0
PowerPMAC Messages QEUIGEIN Terminal OQutput

In the Terminal tab page or
Watch Window, make sure that
the ECATI[0].Enable value turns
to O.

Watch Window

Command/Query Response
Sys.5ervoCount 7778040
ecat[0).Enable 0
ecat[0].MasterState 2
Motor[1].ActPos 2
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6.5.2. Motor Setup

Configure the motor settings for the Controller.

1 Select System — Motor in the
Solution Explorer and right-click
on it, then select Add a Motor....

Selution Explorer
W o-a|p -
Search Solution Explorer (Ctrl+;)
1 KNO1L-ECT
4[5 System
I [ CPU
[ Hardware
4 [ = EtherCAT

4 & Masterd (Deactivated)
Slave 1001 [R88D-KNO1L-ECT] (1001)

Scope to This
MNew Solution Explorer View

Properties Alt+Enter

Add a Motor... I

=] enixml

[ pp_custom_save.cfg
[ pp_custom_savetpl
=] pp_disabletd

=] pp_inc_disabletd
=] pp_inc_startup.tet
[ pp_save.cfg

—% - . ..

2 Adding motor #1

Specify 1 for Motor Number and
click the OK button.

Motor Mumber: [1 v]

Il Template: Mone

Topology: [ EtherCAT T ]

1 Motor values will be uploaded from the PowerPMAC.

ok || Cancel |

3 Select Amplifier.

EtherCAT Type
PowerPMAC
Servo Period
1.000 msec User Units
PhaseCverServoPeriod kol
1.000 None Selected
Amplifier o Motor Encoder
No amplifier selected
¥ o T l
Hardware Interface
Control Type
Signal Type
Interactive
Feedback
’ Test and Set }—"[ Basic Tuning }—"[ Commission
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4 Setting motor Amplifier b .

Manufaciurer

4 LAmpEfier Manufacturer
Vendor I 131

Specify the settings as shown on ;=2 —
. Produrt Deseripbon Slave_100% [RBAD- KNO1L-ECT]
the r|ght. - ).‘ouppnirﬂ(':mlrd.m
Cyehe Syme Posion Contrel True
Cyclic Syne Velocity Contral True
Cyelic Syne Torque Contrel True
Profide Position Control False
Click the Accept button to apply — irerco o
Velpeity Made Contred False
the settings. Lt . \
Vesdar 1D
Vendor 1D of EtherCAT product
YT (B srptie] (Upimeeonss] | Ercoder | (et
Manufacturer

Select OMRON Corporation.
Part Number
Select #x00000002.

4.ECAT Slave Settings
Enter a slave number into Slave Number.
4 AEtherCAT Slave Settings Ed

4 5.FtherCAT
Max Command Output 1000

| Stave Number

5 Select Encoder. EtherCAT Type

PowerPMAC
Servo Period
1.000 msec

PhaseOverServoPeriod
1.000 None Selected

i i

Amplifier v Motor Encoder Q]

User Units

Manufacturer

Omron Corporation (ECAT:13...
Part Number

#x00000002

T ]

"

Hardware Interface

Control Type
Cyclic Position

Signal Type
EtherCAT Interactive
Feedback

l Test and Set l—"[ Basic Tuning ]—"[ Commission ]




6 Specify the settings as shown
on the right.
Click the Accept button to apply
the settings.

B TN E L]

Control Type
Select Cyclic Position.

Primary Feedback
Select ECAT.

4 LAmplifier Control/Signal
Cyelic Position =
Signal Type EtherCAT
4 Lieedback Type
Primary Feedback EtherCAT
Cemtrel Typen
Select the type of P i to thi ports. If the Ampiifier supports mode, make sure the sel this mastches
the ettt on the Amphiser Dreve,

7 Select Hardware Interface.

EtherCAT Type

PowerPMAC
Servo Period
1.000 msec User Units
PhaseOverServoPeriod serint
1.000 None Selected

Amplifier v Motor Encoder \/]
Manufacturer
Omron Corporation (ECAT:13...
Part Number
#x00000002
- PT ]
Hardware Interface  4&
Control Type
Cyclic Position
Signal Type
EtherCAT I Interactive
| Feedback
|
k-
Test and Set H Basic Tuning .—D[ Commission ]
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8 Specify the settings as shown on
the right.
Click the Accept button to apply
the settings.

« LAmpficr Control/Signal

4 2Amphfics Inlerlace

) [$507a] « Dilave_0_GOTA_O_Targeiposition)
tput Channel RO} 56040 - {Skeve_0_6040_0_ Controhward)
Channel 10501 (S6041) - {Skave_0_6041_0_Statusword)

(0:0) (S6064) - (Slave 0 6064 0 Positionactuahval)

Cenmmand Sigasl Charnel
Sehect the Comman d Signal Channel, The ch i shown here are filtered d upon the Command Signal selected in Amplifier Control/Signal section above.

+Up & Encoder ¥ Intersctive Feedback

Command Signal Channel

Select #x607A(Target Position), and specify the motor
control indication value for Target Position.

Amplifier Enable Signal Output Channel

Select #x6040(Controlword), and specify Controlword
for the motor output.

Amplifier Fault Signal Input Channel

Select #x6041(Statusword), and specify Statusword for
the motor input.

Primary Feedback Channel

Select #x6064(Position actual value), and specify
Position actual value for the motor control feedback.

6.5.3. Creation of Operation Check Programs
Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s
Manual and Power PMAC Software Reference Manual for details.

1 Creating the Motion program

In the Solution Explorer pane,
open Project name — PMAC
Script Language — Motion
Programs — progl.pmc.

[ Salution Bxplorer |
+ v

= @ o-d| k-

a

Search Solution Explorer (Ctrl+;)

1 KNO1L-ECT
B [ System
4 [ Clanguage
b [ Background Programs
—] b [ CPLCs
P [d Include
1 Libraries
I [ Realtime Routines
[ Configuration
1 Documentation
3 Log
|Zr PMACL Script Language
P [ Global Includes
1 Kinematic Routines
b [ Libraries
4 [ Motion Program

rograms

idard template for creating Motion Programs.

[
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2 In the programming area of the ”
progl.pmc tab page, write a #1—’>131072X;
program as shown on the right.
OPEN PROG 1
This example program rotates a INC;
. ) . TA800;
motor in the normal direction, TS300:
stops the rotation, then repeats LINEAR;
. . . . <
rotation in the reverse direction }Nh”e B<a
and stops. TA800;
TS300;
TM3000;
X20;
DWELL2000;
X-20;
DWELL2000;
}
CLOSE
Creating the PLC program N e —
3 g p g late for creating Script PLC Programs. i G}‘ o-a | &=
Search Selution Explorer (Ctrl+;) J
In the Solution Explorer pane, e outines
open Project name — PMAC ’ Jéon..ff_:fiz:q_me.cfg
Script Language — PLC Lo
=] pp_inc_disabletdt
Programs — plcl.plc. ) pp_inc_startupioet
i | [0 pp_save.cfy
=] pp_startup.bet
[ systemsetup.cfg
b [ Documentation
P [d Log
4 [ 7 PMAC Script Language
B [ Global Includes
[ Kinematic Routines
B [ Libraries
4 [/Z Motion Programs
‘_D pregl.pme
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4 In the programming area of the
plcl.plc tab page, write a
program as shown on the right.

This example program turns a
servo ON, starts user program 1
for the motor, then exits periodic
execution of the PLC user
program.

open plc 1
while(sys.ecatMasterReady==0){};

P1000=Sys.Time+1;
while(P1000>Sys.Time){};

ECAT[0].Enable=1;

P1000=Sys.Time+1;
while(P1000>Sys.Time){};

cmd"&lenable";

P1000=Sys.Time+5;
while(P1000>Sys.Time){};

cmd"&1b1r";
disable plc 1;

close

5 Setting the start of the user
program

In the Solution Explorer pane,
open Project name —
Configuration —
pp_disable.txt.

CEEGIEELIE L R gl Solution Explorer

use this option remowve the &
-
—@ Search Solution Explorer (Ctrl+;)
1 Libraries
P [ Realtime Routines
4 |7 Configuration
[ pp_custom_save.cfg
[ oo org _cavetn
B pp_disabletxt
=| pp_inc_disabletd
=] pp_inc_startup.bd
A pp_save.cfg
E] pp_startup.tt
[ systemsetup.cfg
I [ Documentation
P [ Leg
4 | PMAC Script Language
P [ Glebal Includes
1 Kinematic Routines
[» [ Libraries
4 [ Motion Programs
[ progl.pmc

@ o-@|p -

6 In the programming area of the
pp_disable.txt tab page, add the
program shown on the right to
the last line.

The pp_disable.txt program is

automatically executed when the

Controller starts.
This example program runs the
PLC1 script.

enable plc 1;
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7 Setting motor control
parameters

In the Solution Explorer pane,
open Project name — PMAC
Script Language — Global
Includes — global
definitions.pmh.

# [z Woters
& Macterd
3 Coorfiraty Syttarm

3 pp_srenly
J po_menup e
3 symemanupaly
B L3 Doslurrest st
[ Leg
PR T LA p—

l * phobisl St peb I

3 Worspmatsc Botings
B Liass

Sohution Exploner

8 In the programming area of the
global definitions.pmh tab page,
write the set values to be set
automatically upon power-on.

Example settings are shown on
the right.

Motor[1].FatalFeLimit=0;
Motor[1].AbortTa= -0.1;
Motor[1].AbortTs= 0;
Motor[1].MaxSpeed= 5000;
Motor[1].JogTa= -0.1;
Motor[1].JogTs= -1;
Motor[1].JogSpeed= 1000;
Motor[1].HomeVel= 1000;

Coord[1]. Tm=100;
Coord[1].FeedTime=60000;
Coord[1].MaxFeedRate=5000;
Coord[1].Td=-0.1;
Coord[1].Ta=-0.1;
Coord[1].Ts=-1;
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6.5.4. Project Data Transfer and Operation Check
Transfer the created project data to the Controller.
When a project is transferred, the program starts automatically and the motor starts rotating.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations. o

Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications

with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.

/\ Caution

The procedure provided in this section checks the operations of the motion

control devices, which may perform unexpected operations.

Take adequate safety measures before starting the checking process described
in this section. Do not start the checking process unless safety is ensured.
When performing the operation check, implement all the steps described in this
section in order to put the output into a safe state.

O
O

1 In the Terminal tab page or Watch Watch Window
Window, make sure that the Command/Query Response
ECAT[O]EnabIe value is 0. Sys.ServoCount 13312872

If the value is 1, run the ‘ ECAT[0].Enable |“
ECAT[0].Enable=0 command from
the Terminal tab page to stop

EtherCAT communications.




2 Downloading a project

Solution Explorer >+ I x
@ o-a|p -
Search Solution Explorer (( 2 ~

Right-click the project name in the

Solution Explorer pane on the PowerPMACS

upper right of the IDE screen, and | & 8 i System
. Rebuild 1 C Language
select Build and Download All Clean £ Configuration
) {1 Documentation

PrOgramS to run the build and New Solution Explorer View £ Log
download. r Build and Download All Programs 1 PMAC Script Language

Map PMAC Variables

Add Macro Project

Export Project with IP Protection...
* H H Export Project Template...

The transferred project is not yet
. ¥ cut Ctrl+X

saved to the Controller at this :

Unload Project
Stage' ¢* Open Folder in File Explorer

M Properties Alt+Enter

If you turn OFF the power to the e . TE—

Controller, the transferred project
will be discarded.

3 Make sure that there are no errors
in the Output Window.

* |f the transfer fails, check details
of the error in the Output Window.
If the error is a program error, you
must review the program.

If the error is related to EtherCAT
settings, return to 6.4 EtherCAT
Communications Setup and check
whether there are any incorrect
settings.

4 The program starts running when
it has been downloaded

Terminal
successfully. S
Make sure that EtherCAT
communications are in the OP
state, and that the motor rotates.

* |f the motor does not rotate,
check that the ECAT[0].Enable
value is 1 in the Terminal tab page
or Watch Window.

If the value is 0, run the following

enable plc '||

command from the Terminal tab

page.
enable plc 1




5 After you have confirmed an

appropriate operation, save the
project to the Controller.

Run the save command from the
Terminal tab page.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal

Available disk spac

Required disk spac : 4
Saving To Flash: Syncing files to flash

Saving To Flash: Mounting the flash

Saving To Flash: Finizhed SAVING to flazh

Save Completed

7.

Appendix

Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File

Create a Configuration File to save
parameters you have changed.

Right-click Configuration in the Solution
Explorer pane, and select Generate

Configuration File.

A Configuration File is added to

Configuration.

L [R88D-1SNO1L-ECT] (1001) Solution Explorer

@ o-a

| » [

] Re8D-1SN
b [ System
b [ Clanguage

=) eniaml

O pp_save.cfg

b [ Documentation
b [dLog

Ctrls; P

Search Selution Explorer (

| 4 B Configuration  [NENENU

1 ECATConfig.cfg

[ pp_custom savecfg | ER  New Solution Explorer View
O pp_custom_save.tpl ¥
=) pp_disablest

=] pp_ine_disablext

2] pp_inc_startup.bet BeualaadCaniacil

=] pp_startup.txt
[0 systemsetup.cfg

b [ PMAC Script Language

y

Scope to This

Properties Alt+Enter

Upload Config Files

Generate Config File

Enter a file name in the textbox, then click 5

the OK button.

@ pp_dificfy

=)

Please tvpe a name for the Config File.

T

| Cancel |
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T R T

3 Right-click on the Configuration File, and O pp_save.cfq
g pp_startup.bt

from the menu, select Check To

Download Config File to include it in files O & Open

b 3D Open With...
to be downloaded. bote
4 [P View Code
4 [ Scope to This

New Solution Explorer View

= Exclude From Project
Solution Ex

o Copy Ctrl+C
X vee oe
R88D-15M Rename

=% Check To Download Config File

B FileEnc & properties Alt+Enter
Enable Ererypurom ™O

B Misc

4 Saving a Project rag0-15n - Powerpnaac o€ 42419 (N
&

dit  Wiew Project Build Debug Toels DeltaTau E

New 4 = | Debug

Open . G}Pmitiun E

project on the computer. E

Close Project

In the File menu, run Save All to save the

Upload Project From PowerPMAC
B Save RBED-15M.cfg Ctrl+S

e BRED-1SM ofa Ag.
F Save All Ctrl+Shift«5

Export 3

=1

Impart 4

Page Setup..

Print... CirleP

Recent Projects and Solutions *
B Eut Alt+Fd

Motor[1].Idata[11]=1176256512
Motor[1].Idata[12]=118874112@
Motor[l].Idata[13]=@
Motor[1].Idata[14]=8
Motor[11.Idatal151=0




I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

2 In the Terminal tab page, type
the $$$*** command to reset the
Controller settings to factory
default.

Terminal

PowerPMAC Messages MIEIUILEIN Terminal Output

3 In the File menu, click Open —
Project/Solution to load the
project that you saved.

@ PowerPMACIDE42119 3 1p: 192168.0.200 Type: MOTION CO|

File | Edit View Debug Tools DeltaTau EtherCAT  Window Help
hew ' |
Open ' 8 Project/Solution... Ctrl+Shift+ 0
alrs S File.. Ctrl+0
Ulose Froject
Upload Project From PowerPMAC
Save Selected Items Ctrl+5
Save Selected ltems As...
W¥ Save Al Ctrl+Shift+S
Export 3
Import 3
Page Setup...
Print... Ctrl+P
Recent Projects and Solutions 3

< =T Alt+F4

7 Right-click Configuration in the
Solution Explorer pane, and
select Download Config Files
to download the file to the
Controller.

_____ - EE=re

v 1 X
ES T,
= @ o-a|p -
—{f Search Solution Explorer (Ctrl+;) P~
1 R88D-15N
P [J System

P [J Clanguage

| | 4 B Confiqueation |

[ Add »

Scope to This
i MNew Selution Explorer View
= M Properties Alt+Enter

Upload Config Files

] Downlead Config Files I

= Generate Config File
+ [ RB8D-1SN.cfg
[ systemsetup.cfg
I+ [ Documentation
P [dLog
P 3 PMAC Script Language

Solution Explorer
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8 Right-click the project name in [ - T -~ x

the Solution Explorer pane, and b @o-ar-
i —A8 Search Solution Explorer (Ctrl+;) P -
select Build and Download All | " RssD g H
. b 3 S ¥ Build
Programs to run the build and b Cacl  Rebuid
4 |Z Col Clean
download.

5 Mew Solution Explorer View

| Build and Download All Programs I
ap araples

Add Macro Project
Export Project with IP Protection...

When the download process is
complete, make sure that there
are no errors in the Output
Window.

Export Project Template...

¥ cut Ctrl+X

-

COmDELmD D

Unload Project

b [ Do (54 Open Folder in File Explorer

b 3 Loc A Properties Alt+Enter
b CdPM RS—

Selution Explorer

Q Stopping a program

If a program is running, execute
the following command from the
Terminal tab page to stop the
program.

disable plc 1 disable plc 1

ECAT[0].Enable=0 PowerPMAC Messages IIEGUIGEN Terminal Output

Terminal

|ECAT[D].EnabIe= 0

PowerPMAC Messages JIEUUIGEIN Terminal Output
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10 Saving the downloaded settings

Terminal

and programs

After the download process is
complete and you make sure
that there are no errors in the

Output Window, run the save F‘EVE'J
command from the Terminal tab  iisiteett "= B
page.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

11 Restarting after download

Terminal

Saving To Flash: Mounting the flash

Run the following command
from the Terminal tab page to
restart the Controller with the
downloaded project.

$$$ 559

PowerPMAC Messages MIEIUILEIN Terminal Output

Saving To Flash: Finished SAVING to flash

Save Completed
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8. Appendix

Troubleshooting

I 8.1. Factors Causing EtherCAT Communications To Be Unavailable, and

Corrective Actions

Description

Factor

Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECATI[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is set to a
value other than 0.

Check the ECATIO].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from Diagnosis Mode of Power PMAC IDE.

Right-click on Master0 (Deactivated) under EtherCAT in the Solution Explorer, then select
Diagnosis Mode to open the Diagnosis Mode page.

Selution Bxplorer
@ o-d

Search Solution Explorer (Cirl

+ -

] RE8D-1SN
4 |5 System
b @ CPU

[3 Hardware
4 [ EtherCAT
4 % .

D Aaurztion Mode
.

Scan EtherCAT Network

b 3 M
Ca Cd Append Slave
b [J En Jaste Slave
: - Ela: Import Slaves from EMI
3 Confis )
b [ Docwy  EXportENIFile
b [3 Log Load Mapping to PowerPMAC
4 [= PMAQ Load Mapping te PowerPMAC From ENI
4 [ Gl
g Activate EtherCAT
| Edit Topology

— K_I.r EoE Endpoint Configuration

Solution Expled = Oy

Scopeto This
MasterQ (Dea =1 pew Solution Explorer View

o B | F & Properties Alt+Enter
E Misc

EtherCAT License Maotors = 256

File Name MasterD (Deactivated)

Full Pat ChUsershdeltataud Decuments' PowerPN
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You can check the status of the slaves in the Diagnosis Mode page.

ECATMap.pmh > QUERWEPEET AT RIS global definitions.pmhb System
Device Editor

State Machine

Current State Pre-Op
Requested State Pre-Op

Init Bootstrap
Change State Pre-Op  Safe-Op

Op

Information Frame Counter

Mumber of found slaves 2 Sent frames
Mumber of slaves in configuration 2 Lost frames
Mumber of DC slaves 2 Cyclic frarmes
DC in-sync Ves Acyclic frames
Topology Ok Yes
Link Connected Yes
Slaves in Master State Yes

Networks: 1 | Slaves: 2 |

| General | Process Data Image " Watch list ” Performance " Variables ” CoE Object-Dictionary " History|

55067
1]

44678
10389

Clear counters

State: & &

Mode: DIAGNOSIS

8.2.2. Checking the Controller Status

In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,

and system.

To display the Status page, click Status on the toolbar.

M Global Status

You can check system errors such as the WDT error.

Status

Mator Status | Coordinate Ststus  Global Status } MACRO Status |

Global Status
Description Status Description
BufSizeErr False NoClocks
ConfigloadErr False ProjectLoadErr
Default True PwrOnFault
FileConfigErr False WDTFault
FlashSizeErr False

Status
False
False
False
False
MoFault
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M Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Status

Motor 1 |-

Description

AmpFault
AmpWarn
AuxFault
BIDir
BlockRequest
ClosedLoop
Csolve
DacLimit
DesVelZero
Encloss
FeFatal
FeWarn
GantryHomed
HomeComplete

HomelnProgress

® Motor activated

Motor Status I Coordinate Status] Global Status] MACRO Status 1

Status Description
LtFault

False InPos

False InterlockStop
False LimitStop

Plus MinusLimit
False PhaseFound
False PlusLimit

False SoftLimit

False SoftLimitDir
[T seftMinusLimit
False SoftPlusLimit
False SpindleMotor
False TraceCount
False TriggerMove
False TriggerNotFound
False TriggerSpeedSel

Status
False
False
False
False
False
False
False
False
Plus
False
False
False
0
False
False
MaxSpeed

A X

M Coordinate Status
You can check deviation errors, limit errors and other states of the coordinate system.

Status *AXx

Motor Status  Coordinate Status l Global Status] MACRO Status ]
Coordinate System 0 =
Description Status Description Status -

AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookAheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LookAheadReCalc False
BufferWarn 0 LookAheadStop False
CC3Active False LookAheadWrap False
CCAddedArc False MinusLimit False
CCMode Off MoveMode LineCircle
CCMoveType Dweell PlusLimit False
CCOffReq False ProgActive False
ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegHaltReq False
Encloss False SegMove Off
EndDelayActive False SegMovelccel False
ErrorStatus NoError SegMoveDecel False
FeedHold Off SegStopReq False
FeFatal False SharpCornerStop False
FeWarn False SoftMinusLimit False
HomeComplete False SoftPlusLimit False
HomelnProgress False TimerEnabled False
LRtFault False TimersEnabled False
InPos False TriggerMove False
InterlockStop False TriggerMotFound False -
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9. Appendix ECAT]Ii] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT

controllers.

Element name

Description

Change

ECATIi].Enable

ECATIi].LPIO[K]

ECAT[i].Slave[]]
ECAT[i].Error

ECATIi].LinkUp
ECATIi].LPDomainOutputState
ECATI[i].LPDomainState
ECATI[i].LPRxTime
ECATI[i].LPTxTime
ECATI[i].MasterStat

ECAT[i]. RTDomainOutputState
ECATI[i]. RTDomainState

Enabling the EtherCAT
network

Elements of low priority
I/O module

Slave elements

Error code of enabling
EtherCAT network

Status data structure
elements

0: Disable, 1: Enable (2 and 3 are not
supported.)
Not supported

Not supported

$ 9811000C: Invalid network
configuration

$ 9811002E: Disconnected network
connection

Not supported
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10. Revision History

Revision Revised date Revised content
code
A 5-Apr, 2019 First edition
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Note: Do not use this document to operate the Unit.
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